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FOREWORD

FURUNO Electric Company thanks you for selecting and purchasing the FURUNO DP-6 NBDP
(Narrow Band Direct Printing) Terminal. We are confident you will discover why the FURUNO
name has become synonymous with quality and reliability. To get maximum performance from
your unit, please carefully read and follow the recommended procedures for operation and
maintenance.

The DP-6 is an advanced, microprocessor controlled NBDP Terminal designed to protect
teleprinting communications from radio signal mutilation due to interference in the radio signal
path. It provides dependable, fully automatic error-free telex communication with other ships,
as well as with any telex subscriber, in full compliance with all GMDSS requirements for
automatic radiotelex operation.

The microprocessor used in the DP-6 enables fully automatic operation of your radio station,
including automatic frequency scanning, unattended reception and transmission of messages,
automatic adjustment of transmitter frequency, and more. Operation is simplified by the use of
menus: Simply move the cursor to items on the screen that you want to select.

The DP-6 provides a complete line of word processing facilities in its Text Editor, where you
may create, edit and store multiple messages for later transmission.

Features

• Simple operation by use of pop-up menus

• LCD displays information in easy-on-your-eyes white on black

• Automatic frequency control and message handling permit unattended operation

• Real time printing of incoming messages

• Storage capacity for 100 user channels

• Remote control of a transceiver by commands entered via the keyboard

• Inputs for IEC61162-1 2nd edition(NMEA0183 version 3.0) data, to display ship's 
L/L position, water temperature, and more on the LCD

• Fully automatic radiotelex by use of macro operation

• Conforms to the following standards and regulations:

IMO Resolution A.806 (19), A.694 (17)

IEC 61097-11/9, 60945 (3rd edition), 61162-1 (2nd edition)

ITU-R M.625-3, M.490, M491-1

ITU-T F.130

ETS 300 067

Program number

TERMINAL UNIT 0550189020 (Version 1.22)

MAIN UNIT 0550187017 (Version 1.17)

MODEM 0550196017 (Version 1.18)
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1. RADIOTELEX COMMUNICATION

1.1 General

Telex subscribers can attest to radiotelex as a reliable and efficient
method for sending and receiving teleprinter connections. Telex
subscribers, especially those who often use HF-band radio circuits,
will also attest that the telex connection is subject to interference
from a variety of sources, including atmospherics, fading and noise
disturbance. This interference plays havoc with radio signals, re-
sulting in the receiving of information different from the intended
information. Thus a means must be provided to prevent mutilation
of radio signals by interference on HF-band radio.

Radiotelex communication today owes its reliability and efficiency
to error detection and correction. The ITU-R defined both a con-
stant-ratio code for automatic error detection and requirements for
the error correction in Recommendation M.625-3.

1.2 Code Description

The DP-6 employs a 7-element synchronous code providing 27 =
128 combinations. Among these 128 combinations, there are 35
constant-ratio combinations having a ratio of 3 (Y) mark bits to 4
(B) space bits. Thus ratio is used to test the validity of each re-
ceived character.

Of the 35 combinations, 32 are used for the required alphanumeric
teleprinter signals. The remaining three 7-element codes are used
exclusively for operational purposes. These are:

Idle Signal  (ARQ Mode), Phasing Signal 1 (FEC Mode)
Idle Signal 
RQ Signal (ARQ mode), Phasing Signal 2 (FEC Mode)

Transmission rate is 100 bauds. If the 4B/3Y ratio is disturbed due
to interference, the output of the receiver is blocked to restrict the
mutilated character from passing on to the teleprinter.

Frequency Shift

The frequency shift is 85 Hz with a center frequency of 1700 Hz,
as specified in ITU-R Recommendation M.625-3.

Space Tone Frequency  1700+85 = 1785 Hz
Mark Tone Frequency   1700-85 = 1615 Hz
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1.3 ARQ Mode (A-Mode)

Description

The ARQ (Automatic Re-transmission request, or Automatic Re-
quest for repetition) Mode allows private communications between
any two stations using semi-duplex communication. Reception
confirmation is done to assure that each character is received cor-
rectly. Since the two stations (automatically) exchange identities,
this affords some degree of protection for confidential messages.

Traffic Exchange Sequence

In the ARQ mode two stations communicate directly with one an-
other. One station sends information and receives controls signals,
while the other station receives information and sends confirming
control signals. The first station is the ISS (Information Sending
Station), and the second is the IRS (Information Receiving Sta-
tion). These functions are interchangeable by a special control sig-
nal.

The station which initiates the call is the Master Station (MS). The
MS initiates the call by sending the selective identity code of the
called station, consisting of an RQ signal and two traffic informa-
tion signals, listening between blocks.

Example: Identity Code XQKM

X RQ Q K M RQ

Calling Block 1 Calling Block 2

Example: Identity Code PEARDBY

P RQ E RQ A R

Calling Block 1 Calling Block 2

D B Y

Calling Block 3

Figure 1-1 How identity code is transmitted

The Slave Station (SS) recognizes own identity code received and
answers it is ready by sending a control signal. The calling station
then initiates normal traffic.

The ISS sends information in blocks of three characters. Each char-
acter is sent at the rate of 100 bauds, amounting to 70 ms for one
character or 210 ms for one character block. The block repetition
cycle is 450 ms, so there is 240 ms during each cycle that the ISS is
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not sending. This time is taken up by propagation time from the
ISS to the IRS, 70 ms for the IRS to send its service information
signal, and the return trip back to the ISS.

The IRS listens between blocks and sends a control signal (CS1 or
CS2) to request either the next block, or retransmission of the last
block in the case of error. Request for retransmission may be re-
peated up to 32 times, until the completed block has been received
error-free. After 32 times, the ISS automatically initiates a new
call.

3 Characters

CONTROL SIGNAL

1 Character

70 ms70 ms

 210 ms 

 450 ms 

INFORMATION

Figure 1-2 ARQ mode traffic exchange timing

Once an entire message is received (error-free), a station may switch
its function from the IRS to the ISS by means of a control signal
(CS3). This change is done by either the ISS by the sequence of "
Figure shift + ? ", or by the IRS operator by activating the "OVER"
control. Upon receipt of CS3, ISS answers with a  block. This
switches the ISS into IRS. However, the original Master and Slave
stations' status remains unchanged, since the Master Station al-
ways controls the radio circuit.

Termination of Communication

Only the ISS may terminate the established circuit. It does this by
sending three "idle signals ." The IRS and ISS exchange control
signals, each reverting to standby after acknowledging each other’ s
control signals. Then, the connection is cleared.
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1.4 FEC Mode (B-Mode)

Description

The FEC mode is for one-way, uninterrupted transmission of mes-
sages, for example, weather forecasts and emergency bulletins, to
no one particular station or stations. The sending station is known
as the BSS (B-Mode Sending Station), the receiving station the
BRS (B-Mode Receiving Station).

This mode uses a simple forward-error correcting (FEC) technique
of sending each character twice at a 280 ms interval. The first trans-
mission is termed DX (direct transmission), the second RX (re-
peated transmission).

Message:   "  a   b   c   d   e   f   g   h   i   j "

First transmission:        a    b    c    d    e    f    g    h    i    j
 
Second  transmission:               a   b   c   d   e   f   g   h   i   j

Output code ex.:           a   b   c  a d  b  e  c  f  d  g  e  h  f  i  g  j  h   i   j

280 ms

Figure 1-3 FEC mode transmission technique

The receiving station tests the DX and RX characters for adher-
ence to the 4-mark/3-space constant ratio, and prints only
unmutilated DX or RX characters, or prints a space if both are
mutilated.

Another version of the FEC mode is the FEC-selective mode. This
mode uses a call code for selective calling to one or more stations.
Only those stations with the correct code will receive the data cor-
rectly.

Initiating a Call

When a BSS initiates a broadcast call it transmits synchronizing
signals to align phasing of the BRS. Upon detection of this signal
the BRS’s are switched to the receiving condition and will remain
in this condition until the completion of the message. If the muti-
lated character error rate exceeds a certain percentage, the BRS
reverts to standby condition.

Termination of Communication

The sending station sends three consecutive idle signals α imme-
diately after the last transmitted information signal in the DX posi-
tion.
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2. SYSTEM OVERVIEW

2.1 System Configuration

SSB RADIO-
TELEPHONE

MAIN UNIT
DP-6

DSC

TERMINAL UNIT
IB-581

NAV AID

PRINTER
PP-510

24 VDC

24 VDC

24 VDC

______: Standard supply
- - - - - -: Optional supply

Figure 2-1 System configuration
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2.2 Turning on the System

There is no particular order for turning on the units of the system.
The figure below shows the location of power switches on the units
of the system. Note that it takes about six seconds for the LCD to
light after the power is turned on.

POWER switch

POWER switch

POWER switch

TERMINAL UNIT

MAIN UNIT

PRINTER

Figure 2-2 Main unit, terminal unit and printer

2.3 Equipment Description

Terminal Unit

The terminal unit consists of a 9" visual display, a floppy disk drive
and a keyboard. The floppy disk drive provides for unlimited stor-
age of files on floppy disks. Controls for power and  adjustment of
display brilliance and contrast are provided on the front panel.

When the terminal unit is turned on the communication status dis-
play appears. This is where all phases of communication begin.

Station Name    :  
Frequency (T/R) :          /        (kHz)  Comm Mode : Auto
Comm Status     :  Connect Send Lock Error  
Sending Volume  :      (%)   ARQ Error : 0   ARQ Time : 0(sec)

1:File 2:Edit 3:Operate 4:Window 5:Station 6:System 7:WRU 8:HR 9:Over 10:Break
1996-11-15 13:26:45:45    Caps Eng

Figure 2-3 Communication status display
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Keyboard

unit is operated from the keyboard, and is almost 100% keyboard
controlled. Operation is simplified by the use of menus which you
access by pressing a function key, numbered F1-F10 at the top of
the keyboard. The figure below shows the function menus and their
corresponding function keys.

Figure 2-4 Keyboard

Note: C (Euro mark) on 
5

%

C  key is not used.

Main Unit

The main unit mainly acts as the interface between radio equip-
ment, navigator and the terminal unit.

Printer (option)

The printer prints messages. Refer to its operator's manual for op-
eration.

~

` 21 3 4 6 7 8 9 0 - =

_ +)* ( 9 *87^ &$#@!

Q W E R T Y U I O P

[ ]

{ }

\

|

A S D F G H J K L : +

;

"

'

Tab

Caps Lock

Z X C V B N M < > ? /

/.,

1 2 3

4 5 6

0Shift

Fn Ctrl Alt Alt Ctrl

Home End PgDn

PgUp

Shift

Enter

Backspace

Esc F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 Num
Lock

Prt Sc

SysRq

Scroll
Lock

Pause

Break

Insert Delete

FILE   EDIT   OPERATE   WINDOW   STATION   SYSTEM   WRU   HR   OVER   BREAK

F11 F12

5

%

C
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2.4 Function Keys, Menu Operation

The function keys at the top of the keyboard control most opera-
tions of this unit through a menu system.

Menu Conventions

Inverse video

As you move the cursor down through a menu, selected item ini-
tially shown as white on black, inverses to black on white. This
highlighting indicates that it is available for selection.

Underline

The underline shows current selection. In the figure below, for
example, the underline is beneath "Receive".

Operation
Station
Start Time
Stop Time
Receive/Send
File to send

: OP1
: NAGASAKI
:  8:35: 0
:  9:10: 0
: Receive Send
:

Timer Operation Set Up

Figure 2-5 The auto operation set up screen

Basic Menu Operation

Selecting menus

Press appropriate function key to open a menu. To display the File
menu, for example, press function key [F1].

1: New
2: Open
3: Close

4: Delete

5: Rename

6: Real Time Printing
7: File to Print
8: Cancel Printing

9: Clear Buffer

0: Floppy Disk Format

File

Figure 2-6 File menu
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Selecting menu items and options

Menu items can be selected by pressing appropriate numeric key
or selecting menu desired with the arrow keys and pressing the
[Enter] key. Menu options can be selected by operating the [←]/
[→] keys. Press the [Enter] key to register selection and close the
menu.

Function Key Description

Function key [F1]: File menu

The File menu is where you will create, edit, save and print telex
messages.

1: New
2: Open
3: Close

4: Delete

5: Rename

6: Real Time Printing
7: File to Print
8: Cancel Printing

9: Clear Buffer

0: Floppy Disk Format

File

Figure 2-7 File menu

1: New Opens a new untitled window.

2: Open Opens files.

3: Close Closes files

4: Delete Deletes files.

5: Rename Renames files.

6: Real Time Printing Turns real time printing on/off.

7: File to Print Prints files.

8: Cancel Printing Stops printing.

9: Clear Buffer Clears the communication buffer.

0: Floppy Disk Format Formats a floppy disk.
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Function key [F2]: Edit menu

The Edit menu provides a full line of editing features. This menu is
only operative while creating a message.

1: Undo

2: Cut
3: Copy
4: Paste

5: Select All

6: Search
7: Replace

8: Goto Top
9: Goto Bottom
0: Goto Line

A: Change Text

Edit

Figure 2-8 Edit menu

1: Undo Cancels the last change (cut, copy or paste).

2: Cut Removes the selected text and stores it in
the paste buffer. (Previous text in the paste
buffer is cleared.)

3: Copy Copies the selected text and stores in the
paste buffer. (Previous text in the paste
buffer is cleared.)

4: Paste Inserts the text stored in the paste buffer at
the current location of the cursor.

5: Select All Selects the entire current file for cut and
copy.

6: Search Searches a file for a character string.

7: Replace Replaces a word with a different word or
character string.

8: Goto Top Brings the cursor to the top line of the cur-
rent file.

9: Goto Bottom Brings the cursor to last line of the current
file.

0: Goto Line Moves the cursor to the desired line in the
current file.

A: Change Text Switches between the display window 1 and
2.
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Function key [F3]: Operate menu

The Operate menu controls transmitting and receiving.

1: Call Station

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: High Tension ON

9: Manual Calling
0: Set Frequency

Operate

2: Macro Operation

Figure 2-9 Operate menu

1: Call Station Selects a station from the station list.

2: Macro Operation Enables fully automatic operation.

3: File to Send Selects a file (to transmit).

4: Cancel Sending Stops sending a file.

5: Scan Start/Stop Starts/stops frequency scanning.

6: Manual Reception Selects communication mode for re-
ception; AUTO/ARQ/FEC.

7: Timer Operation Timer programming.

8: High Tension ON/OFF Turns on/off transmitter high volt-
age on a FURUNO radio.

9: Manual Calling Sets Tx mode and subscriber's ID
number in manual calling.

0: Set Frequency Sets Tx and Rx frequencies in
manual calling.
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Function key [F4]: Window menu

The Window menu displays data together with current screen.

1: Display NMEA Data

2: Calendar

3: Remote A  (TX/RX)
4: Remote B  (DSC)

5: Distress Frequency Table

Window

Figure 2-10 Window menu

1: Display NMEA Data Displays NMEA data: position, speed,
Heading, water temperature and depth.

2: Calendar Displays desired calendar month and year.

3/4: Remote A/B Entering commands on this screen enables
remote control of a FURUNO radio trans-
ceiver and DSC terminal connected to Re-
mote A and Remote B terminals.

5: Distress Frequency Table Displays all distress frequencies.
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Function key [F5]: Station menu

The Station menu provides for storage of stations, timer programs,
channels, and various ID codes.

1: Station Entry

2: Timer Operation Entry

3: Scan Entry

4: User Channel Entry

5: Answerback Code Entry

6: Group ID Entry (4/5 digit)
7: Group ID Entry (9 digit)
8: Select ID Entry (4/5 digit)
9: Select ID Entry (9 digit)

Station

Figure 2-11 Station menu

1: Station Entry Registers stations.

2: Timer Operation Entry Registers timer programs.

3: Scan Entry Creates scan groups for scanning.

4: User Channel Entry Registers user channels.

5: Answerback Code Entry Registers own ship's answerback code.

6: Group ID Entry Registers own ship's group ID codes.
                  (4/5 digit)

7: Group ID Entry Registers own ship's group ID codes.
                  (9 digit)

8: Select ID Entry Registers own ship's selective ID codes.
                  (4/5 digit)

9: Select ID Entry Registers own ship's selective ID codes.
                  (4/5 digit)
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Function key [F6]: System menu

The System menu is mainly for use by technicians and includes
diagnostic tests (self test). To change settings, select Change on
the Setup line and operate arrow keys to select item and option.
Press the [Enter] key to register selection and close the menu.

Setup

Slave Delay
BK Timing PreTone
         PostTone
Mute Timing PreBK
           PostBK

Modem Output Level

MIF Tune
    Freeze
    AGC
    Emission

TX/RX MSG Save
Edit Before sending

Time System
Time & Date
Display Mode
Self Test

System
Lock  Change   Default

 5 msec (0- 50 msec)
10 msec (0-100 msec)
 0 msec (0- 20 msec)
 0 msec (0- 20 msec)
 0 msec (0- 20 msec)

0 dBm (-30 - +10 dBm)

OFF  O N
OFF  O N
OFF  O N
OFF  O N

OFF  O N
OFF  O N

OFF UTC SMT JST
1997/3/16/10:00:00
Normal Reverse

Figure 2-12 System menu

Setup Locks, enables change or restores default
system settings.

Slave Delay Sets the length of the slave delay timing
in the ARQ mode.

BK Timing PreTone Sets the timing for the leading edge of
the BK signal in the ARQ mode.

BK Timing PostTone Sets the timing for the trailing edge of
the BK signal in the ARQ mode.

Mute Timing PreBK Sets the timing for the leading edge of
the mute signal in the ARQ mode.

Mute Timing PostBK Sets the timing for the trailing edge of
the mute signal in the ARQ mode.

Modem Output Level Sets modem output level.

MIF Tune Turn on to send antenna coupler tuning
command. (Requires FURUNO Radio
Equpment.)



2-11

MIF Freeze Turn on to send "freeze" command to
radio equipment connected. (Requires
FURUNO radio equipment.)

MIF AGC Turn on to automatically control gain in
telex mode. (Requires radio equipment
which supports AGC command in MIF
format.)

MIF Emission Turn on to automatically change mode
at radio equipment to telex. (Requires
radio equipment which supports Emis-
sion command in MIF format.)

TX/RX MSG Save Turn on to automatically save incoming
and outgoing messages to floppy disk.

Edit Before Sending "No" transmits keying operation one by
one. "Yes" transmits message only when
the [Enter] key is pressed after confirm-
ing text typed.

Time System Select Time system. SMT is local time
and JST is Japan standard time.

Time & Date Enter Date and time manually.  If a navi-
gation device is connected, the time is
automatically set when the power is
turned on or whenever the time system
is switched.  Manual entry takes prior-
ity over automatic entry.  If there is no
the navigation data input, it takes more
than extra 10 seconds for automatic ini-
tial settings.

Display mode Select display mode between normal and
reverse.

Function key [F7]: WRU (Who Are You?)

In the ARQ mode, requests other station's answerback code.

Function key [F8]: HR (Here Is)

In the ARQ mode, sends your ship's answerback code.
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Function key [F9]: OVER

In the ARQ mode, changes the direction of traffic; the information
receiving station becomes the information sending station, the in-
formation sending station becomes the information receiving sta-
tion.

Function key [F10]: BREAK

Disconnects the communications line.
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3. PREPARATIONS FOR
TRANSMISSION AND RECEPTION

This chapter provides the procedures necessary for preparing the
DP-6 for transmitting and receiving. For automatic telex, you will
need to register the following;

• Your ship's ID and answerback codes

• Stations

• Timer programs

• Scan channel groups

• User channels

3.1 Registering Answerback Code & ID Codes

Enter your ship's answerback code and ID code as follows.

Note: The answerback and ID codes cannot be changed once en-
tered; be sure to enter the codes correctly.

Registering Answerback Code

1. Press function key [F5] and then the [5] key. The display should
look something like Figure 3-1.

Answerback Code
Answerback Code Entry

Figure 3-1 Answerback code entry screen

2. Enter your ship's answerback code (max. 20 characters, includ-
ing spaces) and press the [Enter] key. The prompt OK/CAN-
CEL asks for verification of data. If code is correct, press the
[Enter] key again.

Note: Example of answerback code 12345789 ABCF X.
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3. For final verification of the data, the Caution shown in Figure
3-2 appears. If code is correct, press the [Enter] key again.

Answerback Code

123456789 FURU X

Answerback Code Entry

 O  K

Cancel

 Caution
Confirm the 'CODE' before pressing ENTER key.
You cannot change the CODE once it has been entered.

Figure 3-2 Message for confirmation of code entered

Registering ID Codes

1. Press function key [F5] and then the [6], [7], [8] or [9] key to
enter the Group ID Code (4 or 5 digits), Group ID Code (9
digits), Select ID Code (4/5 digits) or Select ID Code (9 dig-
its), respectively.

Select ID Code (4/5)
Select ID Entry

Figure 3-3 ID code screen

2. Enter group ID or select ID and then press the [Enter] key. A
prompt asks for verification of data. If ID is correct, press the
[Enter] key.

3. For final verification of the data, the Caution shown in Figure
3-4. If ID is correct, press the [Enter] key again.

Select ID Code (4/5)
12345

Select ID Entry

 O  K

Cancel

 Caution
Confirm the 'CODE' before pressing ENTER key.
You cannot change the CODE once it has been entered.

Figure 3-4 Message for confirmation of code entered
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3.2 Station List

The station list provides abbreviated dialing with storage for up to
50 stations, one frequency pair (Rx and Tx) per station. For sta-
tions which have more than one frequency pair, you might add a
suffix to the station name to denote multiple frequency pairs. For
example, station name FURUNO followed by -1, -2, -3, etc. for
each frequency pair required.

Registering Stations

1. Press function key [F5] followed by the [1] key. The Station
Entry screen appears.

Station Entry

Create
Change

Station List

Station Set Up

Station  : 
ID Code  :
Mode     : ARQ FEC
CH/Table : Channel ScanTable
Num/Table:

Figure 3-5 Station entry screen

2. On the right-hand side on the screen you should see Create and
Change and Create should be underlined. If it is not, underline
it by pressing [ ], [ ] and the [Enter] key.

3. The cursor is now on the Station line. Enter station name, us-
ing up to 18 characters.

4. Press the [] key to go to the ID Code line. Enter station ID
code.

5. Press the [] key to go to the Mode line. Select communica-
tion mode among the following;

ARQ: Automatic Retransmission Request
FEC: Forward Error Correction

6. Press the [] key to go to the CH/Table line. Select ScanTable
with [ ] or [ ] key to choose channel.

7. Press the [] key to go to the Num/Table line.
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8. If you selected "Channel" enter ITU channel number (see ap-
pendix) or User channel number (see page 3-9).

If you selected the "ScanTable", press the [ ] key to show a
scan group list registered (see page 3-7). Select a scan group
name by using the [ ] or [ ] key followed by pressing the
[Enter] key.

 Scanning Group List 

MARITEX-A

MARITEX-B

MARITEX-C

FURUNO

CHOUSHI

MARITEX-F

9. Press the [Enter] key. The prompt OK/CANCEL asks for veri-
fication of data.

CREATE

CHANGE

 O  K

CANCEL

Figure 3-6 OK/CANCEL prompt

10. If the data are correct, press the [Enter] key. (To cancel entry,
place cursor on CANCEL by pressing the [ ] key, and then hit
the [Enter] key. Data entered are erased.)

To register other stations, select Create again and then press the
[Enter] key. Repeat steps 3 – 10.

To confirm the data registered, press the [ ] key to get into the
Station Set Up window.

Note: If you enter a station which exists the indication "Station by
that name already exists. Press any key to escape." appears. Press
any key to return to the Station List. Check the list.

Editing/Deleting Stations

1. Press function key [F5] and then the [1] key.

2. Select station from the Station List.

3. Select Change and press the [Enter] key.
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4. Do one of the following;

Edit station: Use [ ], [ ] and the [Backspace] key to make
corrections.

Delete station: Erase station name with the [Backspace] key.

5. Press the [Enter] key twice.

6. Press the [Esc] key.

3.3 Timer Programming

A built-in timer allows you to automatically receive and transmit
files. 10 timer programs can be registered.

Registering Timer Programs

1. Press function key [F5]. Press the [2] key to select Timer Op-
eration Entry. The screen should look something like Figure 3-
7.

Create
Change

Timer Operation Entry

Timer Operation List

Timer Operation Set Up

Operation      : 
Station        :
Start Time     :  0: 0: 0
Stop Time      :  0: 0: 0
Receive/Send   : Receive Send
File to Send   :

Figure 3-7 Timer operation entry screen

2. If Create is not underlined, press [], [ ] and the [Enter] key
to underline it.

3. Enter a suitable operation name on the Operation line. Any
alphanumeric characters may be used. See note 2 on the next
page.

4. Place the cursor on the Station line. Press the [] key to dis-
play the Station List. Select a station and press the [Enter] key.
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5. Press the [] key to advance the cursor to the Start Time line.
Enter start time in 24-hour notation. To have the operation start
at 8:35, for example, the keying sequence would be;

[0]   [8]   [3]   [5]   [0]   [0]

6. Press the [] key to advance the cursor to the Stop Time line.
Enter stop time.

7. Press the [] key to advance the cursor to the Receive/Send
line. Select operation category; Receive or Send.

8. For send, insert floppy disk in drive and designate the file to
send. Press the [] key to advance the cursor to the File to
Send line. Press the [] key to display the file list, select a file,
and press the [Enter] key.

9. Press the [Enter] key.

10. Press the [Enter] key. The operation name appears in the Timer
Operation List. See note 2 and 3.

Note 1: To change a timer program, select it on the Timer Opera-
tion List, select Change and press the [Enter] key. Enter new data.

Note 2: If the operation name entered already exists, the display
shows the following message: Operation name already exists. Press
any key to escape. Press any key and change the operation name.

Note 3: If the station name entered has not been registered, the
display shows the following message: Station by that name does
not exists. Press any key to escape. Press any key and register the
station as shown on page 3-3.

Editing/Deleting Timer Programs

1. Press function key [F5] and the [2] key.

2. Select timer program from the Timer Program List.

3. Select Change and press the [Enter] key.

4. Do one of the following;

Edit program: Use [ ], [ ] and the [Backspace] key to
make corrections.

Delete program: Erase operation name with the [Backspace]
key.

5. Press the [Enter] key twice.

6. Press the [Esc] key.
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3.4 Scan Channel Groups

The DP-6 can automatically control radio equipment through chan-
nel scanning. The radio equipment scans a number of channels
(according to your selection), stopping when your own ID code is
detected in an incoming signal. The transmitter is tuned to the cor-
responding transmitter frequency, the communication link is es-
tablished and the traffic is automatically exchanged. Scanning
resumes once the link is disconnected.

You may store a maximum of 10 scan groups, 20 channels per
group. Note that scanning is only possible in the ARQ and FEC
modes.

Registering Scan Channel Groups

1. Press function key [F5] followed by the [3] key to display the
Scan Entry screen.

Create
Change

Scan Entry

Scanning Group List

Scanning Set Up

Group Name     : 
Ch Dwell Time  : 4.5 sec (2.7-4.5 sec)
Mode    : AUTO ARQ FEC
Auto Search    : OFF ON

No    Channel    Rx Freq    Tx Freq    Pass/Scan
1
2
3
4
5
6

Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan

▼

Figure 3-8 Scan entry screen

2. If Create is not underlined, press [], [ ] and the [Enter] key
to underline it.

3. The cursor is on the Group Name line. Enter suitable group
name.

4. Press the [] key to advance the cursor to the CH Dwell Time
line. Enter channel dwell time in seconds. Dwell time is the
time in seconds the receiver waits on each channel in a scan
group before it selects the next frequency.
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5. Press the [ ] key to advance the cursor to Mode, and then se-
lect the communication mode; AUTO, ARQ or FEC.

Note: To register the Scanning Channel Group for ARQ, select
ARQ.  For FEC, select FEC.

AUTO is used to register scanning channel group when both
ARQ and FEC exist in the same Scanning Channel Group.

When you select scan group by call sration menu, set Mode to
FEC (See Page 5-7).

6. Press the [ ] key to advance the cursor to Auto Search. Select
Auto Search to ON or OFF.

Auto Search ON: Radio stops scanning when it finds the
strongest signal (highest S/N ratio).  To
find strongest signal, the radio scans all
this channel, which may take some time.
Therefore, use this setting where signal
propagation is poor.

Auto Search OFF: Radio stops scanning on the first signal it
finds.  We recommend that you set Auto
Search to OFF where signal propagation
is good.

7. Advance the cursor to line no. 1 in the Scanning Set Up win-
dow. Enter channel number (ITU or user channels) and press
the [ ] key to select "Scan".

8. Press the [ ] key to advance the cursor to line No. 2. Enter
channel number.

9. Enter other channel numbers and then press the [Enter] key.

10. Press the [Enter] key again to save the data.

To register another scan group, repeat steps 2 – 9.

Note: When the scan group memory is full the DP-6 displays "Scan
group information full."

Editing/Deleting Scan Channel Groups

1. Press function key [F5] and the [3] key. Select scan group from
the Scanning Group List.

2. Select Change and press the [Enter] key.

3. Place the cursor on the line (channel) to change.
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4. Do one of the following;

Editing channels: Press the [Backspace] key to delete the chan-
nel number and then enter new channel number.

Adding channels: Enter channel number on a blank line.

Deleting channels: Delete group name with the [Backspace]
key.

Disabling channels temporarily: Press the [ ] key to under-
line Pass.

5. Press the [Enter] key twice.

6. Press the [Esc] key.

3.5 User Channels

The user channel list provides storage for up to 100 user channels,
numbered 0 – 99. Note that user channels may be used in channel
scanning.

Registering User Channels

1. Press function key [F5] and then the [4] key. The User Channel
Entry screen appears.

User Channel Entry

Create
Change

Channel List

Channel Set Up

Channel : 
Tx Freq  :         0.00
Rx Freq  :         0.00

Figure 3-9 User channel entry screen

2. If Create is not underlined, press [], [ ] and the [Enter] key
to underline it.

3. Enter channel number on the Channel line.

4. Advance the cursor to the Tx Freq line. Enter Tx frequency.

5. Advance the cursor to the Rx Freq line. Enter Rx frequency.
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6. Press the [Enter] key.

7. Press the [Enter] key. Channel number entered appears in the
Channel List.

To register another user channel, repeat steps 2 – 7.

Editing/Deleting User Channels

1. Press function key [F5] and then the [4] key.

2. Select channel from the Channel List.

3. Select Change and press the [Enter] key.

4. Do one of the following;

Edit channel: Use [ ], [ ] and the [Backspace] key to
make corrections.

Delete channel: Erase channel number with the [Backspace]
key.

5. Press the [Enter] key twice.

6. Press the [Esc] key.
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4. FILE OPERATIONS

This chapter mainly describes how to create, save, edit and print
files. The Edit menu provides a full lineup of editing facilities in-
cluding search and replace.

4.1 Creating Files

1. Press function key [F1] to display the File menu.

1: New
2: Open
3: Close

4: Delete

5: Rename

6: Real Time Printing
7: File to Print
8: Cancel Printing

9: Clear Buffer

0: Floppy Disk Format

File

Figure 4-1 File menu

2. Press the [1] key.

3. Type your message.

Note:  Do not use lower case letters, #, &, *, $ or % in telex mes-
sages. Also, do not put “$$$” (three successive $s) in the middle of
a Tx message, but at the end. The communication line is automati-
cally disconnected when the DP-6 detects this string.
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4.2 Saving a File

Before you can save a file to a floppy disk, the disk must be for-
matted. 2HD Type is only available.

Formatting Floppy Disks

1. Press function key [F1].
2. Press the [0] key to select "Floppy Disk Format".
3. Press the [↑] key to select "YES".
4. Press the [Enter] key.
5. Insert a new floppy disk and press the [Enter] key.

Saving a File

1. Press function key [F1] to display the File menu.

2. Press the [3] key. The screen should look something like Fig-
ure 4-2.

Save file ?

( UNTITLED1   )

Close Text

Yes

No

Figure 4-2 Close text screen

3. Press the [Enter] key. Enter file name, using up to eight charac-
ters.

You may use any alphabet or numeric on the keyboard. But
you may not use the following punctuation symbols;

        |    :   "     >   <   ;

!

You may add an extension at the end of the file name, for ex-
ample, .TXT, to distinguish text file from macro file.

4. Press the [Enter] key.

Note:  When the working area is full, the message "File can't open"
appears. Then, you would close a file to clear a working area in
order to open the file desired.
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4.3 Editing Files

Cutting and Pasting Text

You can delete, move and copy text by using the Cut, Copy and
Paste functions in the Edit menu.

1: Undo

2: Cut
3: Copy
4: Paste

5: Select All

6: Search
7: Replace

8: Goto Top
9: Goto Bottom
0: Goto Line

A: Change Text

Edit

Figure 4-3 Edit menu

Cutting text

1. Place the cursor on the first character of the text to be cut.

2. Highlight the text to be cut by pressing and holding the [Shift]
key while pressing the [ ]. If you highlight text which you do
not want to cut, press the [] to adjust the highlight.

<[1]UNTITLED1>

CONGULATULATION ON YOUR CHOICE OF DP-6
INMARSAT B MOBILE EARTH STATION.
WE ARE CONFIDENT THAT YOU WILL ENJOY MANY YEARS OF
OPERATION WITH THIS FINE PIECE OF EQUIPMENT

Figure 4-4 The highlight

3. Press function key [F2] and the [2] key. The highlighted text is
cut and the remaining text is reformatted.

If a mistake is made, you can restore the text by immediately se-
lecting Undo in the Edit menu.
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Pasting text

To paste the cut text to a new location;

1. Place the cursor at the exact spot in the message where the cut
text is to start.

2. Press function key [F2] and the [4] key.

Copying and Pasting Text

You may copy a portion of text and paste it elsewhere.

1. Select the text to copy (see the "cutting" procedure above ).

2. Press function key [F2] and the [3] key.

The text selected is copied in the paste buffer memory where
the cut or copied text is stored. The display returns to the nor-
mal screen.

3. Place the cursor at the exact spot in the message where the
copied text is to start.

4. Press function key [F2] and the [4] key.

Clearing the Paste Buffer

Press function key [F1] and the [9] key.

Undo

Use the Undo feature to return the file to its most recent state. For
example, you have cut text but want to restore it. Then, you would
select Undo in the Edit menu to restore the text to its most recent
location.

Select All

The Select All feature lets you select all of the file currently dis-
played. This feature can be useful when you want to combine files.
The procedure below explains how to tack the file loaded in work-
ing memory 1 onto the end of the file loaded in working memory
2.
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1. Load the file to be copied from a floppy disk in working memory
1.

2. Press function key [F2] and the [5] key. The entire file appears
in inverse video.

3. Press function key [F2] and the [3] key. The file is placed in the
paste buffer memory.

4. Load the file to be combined in working memory 2.

5. Place the cursor at the exact spot in the message where the text
now in the paste buffer memory is to start and press the [Ins]
key.

Floppy
Disk

Working 
Memory 1

Working 
Memory 2

Paste 
Buffer 
Memory

Open
file

Open
file

Transfer
(copy)

Paste (Combine)

1

3

2

4

Holds cut or
copied text

Figure 4-5 Cut and paste flow diagram

Searching Text

The Search feature lets you search for text in a forward or back-
ward direction.

1. Display a text and press function key [F2] and the [6] key. The
Search display appears.

Forward

Search

Search string : 

                To quit: ESC

Backward

Dir

Figure 4-6 Search screen

2. Type the word you want to find. Select Forward or Backward
to search the file in a forward or backward direction respec-
tively from the cursor position. Press the [Enter] key to begin
the search.

When the unit finds the word, the cursor stops at the first character
of the word. Press the [Enter] key to continue the search.
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Replacing Text

The Replace feature helps you replace every occurrence of a word
or phase with another word or phase in a file.

1. Press function key [F2] and the [7] key. The Replace display
appears.

All

Query

Replace

Search string : 
Replace with  :

        To quit: ESC

Forward

Backward

Dir Mode

Figure 4-7 Replace screen

2. Type the word you want to replace on the "Search string " line.

3. Press the [] to select "Replace with." Type the new word.

4. Select Forward or Backward to search the file in a forward or
backward direction respectively from the cursor position.

5. Select whether you want to be queried or not each time the
word is found.

Query: Stop at each occurrence of word to answer yes or no
to replacement.

All: Replace every occurrence of word without stopping
to confirm.

6. Press the [Enter] key to start the replacement.

Goto Line

This feature places the cursor at the head of a line desired. Press
function key [F2] and the [9] key. The following display appears.

Goto Line

Jump to Line No. : 

Figure 4-8 Goto line screen

Key in line number and press the [Enter] key. The cursor shifts to
the head of the line selected.
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4.4 Opening Files

Two working areas (called working area 1 and working area 2) are
provided to which you can load a file, and one file may be dis-
played on the LCD.

File 1

2File

FLOPPY DISK WORKING 
AREA (2)

one file DISPLAY

LCD

Figure 4-9 Working memories

Opening a File

1. Press function key [F1] to display the File menu.

2. Press the [2] key. A chronological list of files on the floppy
disk appears.

3. Select a file. Press the [Enter] key.

The file appears and the title bar shows the file name. You may
repeat this procedure to load another file into a working area.

Switching Between Files

Two files can be opened and one displayed on the LCD. To switch
between files do the following;

1. Press function key [F2].

2. Press the [A] key to switch files.
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4.5 Renaming Files

To rename a file;

1. Press function key [F1].

2. Press the [5] key.

3. Select file and press the [Enter] key.

4. Enter new name.

5. Press the [Enter] key.

4.6 Saving a File Under a New Name

You may save a file under a new name as follows;

1. Open a file.

2. Edit the file as necessary.

3. Press function key [F1].

4. Press the [3] key to clear the screen.

5. Press the [Y] key.

6. Press the [Backspace] key to erase the original name and then
enter a new name.

7. Press the [Enter] key.

4.7 Deleting Files

1. Press function key [F1].

2. Press the [4] key.

3. Select file to delete and then press the [Enter] key.

4. Press the [Enter] key again. (To cancel, press the [] key fol-
lowed by the [Enter] key.)
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4.8 Real Time Printing

An incoming or outgoing message can be printed out while it is
being received or transmitted.

1. Press function key [F1] to display the File menu.

2. Press the [6] key to turn real time printing on/off.

PRINT appears in inverse video when real time printing is on.

4.9 Printing Files

You can print a file as follows;

1. Press function key [F1].

2. Press the [7] key.

3. Select file and press the [Enter] key.

4. Press the [Y] key.

If the file could not be printed, "Cannot print. Check connection
between printer and terminal. Press any key to escape." is displayed.



4-10

4.10 Communications Log

Transmission/Reception date and time, ID, mode, Tx/Rx frequen-
cies and station name are recorded for each message received or
transmitted. ("TX/RX MSG Save" must be ON in the System menu
to automatically save Tx and Rx messages.)

Displaying the Communications Log (Log File)

1. Press function key [F1] and then the [2] key.

2. Select Log File and press the [Enter] key. A list of Tx and Rx
messages appears. See Figure 4-10.

Note:  The Log File can store about 230 communication files. When
it becomes full, an error message appears to alert you. If this oc-
curs, delete all log files.

Open Text

Load/Merge(TAB:Change)
File Name           Size  Date & Time

LOG FILE             95k 96-12-13 14:20
TELEX               136k 96-01-08 20:32
NBDP                 28k 96-01-09 20:31
DO-5                 41k 96-02-12 20:30

File Count :  4  Memory :   4k Used  96k Avairable

[1]B:\LOG_FILE

 Date     Time    Mode      ID  TX Freq. RX Freq.    Station name
12-13 14:17 14:19 FEC     1234   8765.00  8965.00  CHOUSHI-8M
12-13 14:19 14:20 FEC     1234   8765.00  8965.00  CHOUSHI-8M
12-13 14:20 14:23 FEC     1234   8765.00  8965.00  CHOUSHI-8M

Figure 4-10 Log file

Printing the Log File

1. Press function key [F1] and then the [7] key.

2. Select Log File and press the [Enter] key.

3. Press the [Y] key.
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5. TRANSMISSION, RECEPTION

This chapter shows you how to transmit and receive Telex mes-
sages. Also included are the procedures for frequency scanning,
and automatic operation.

5.1 Manual Calling

The simplest way to communicate with a Telex subscriber is Manual
Calling. For the ARQ mode, you may display beforehand the mes-
sage to send or type message manually.

1. Press function key [F3] to display the Operate menu.

1: Call Station
2: Macro Operation

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: High Tension ON

9: Manual Calling
0: Set Frequency

Operate

Figure 5-1 Operate menu

2. Press the [0] key. The Set Frequency screen appears.

Tx Freq:        0.00
RX Freq:        0.00

Set Frequency

Figure 5-2 Set frequency screen
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3. Input frequency pair. This can only be done with FURUNO
transceivers.

For other makes of transceiver, set a frequency pair at the trans-
ceiver. Omit steps 1, 2 and 3.

4. Press the [Enter] key.

5. Press function key [F3] again and then the [9] key. The follow-
ing screen appears.

Mode : ARQ FEC 
ID   :

Manual Calling

Figure 5-3 Manual calling screen

6. Select communication mode.

7. Press the [ ] key and input party's ID number.

8. Press the [Enter] key to connect the communication line. Then,
the line will be connected a short while.

For ARQ mode, follow the next procedure. For FEC mode,
type your message and go to step 13.

9. Press function key [F7] (WRU). The party's answerback code
appears on the screen.

Note:  Step 9 and 10 are needed for ship to ship calling only.

10. Press function key [F8] (HR). You ship's answerback code is
sent to the party.

11. Press the [Enter] key and type your message.

12. If you want to the party's response, press function key [F9]
(Over).

13. Press function key [F10] to disconnect the line.
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5.2 Calling a Station

1. Press function key [F3] to display the Operate menu.

1: Call Station
2: Macro Operation

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: High Tension ON

9: Manual Calling
0: Set Frequency

Operate

Figure 5-4 Operate menu

2. Press the [1] key to display the Station List.

3. Select the station you wish to call.

4. Press the [Enter] key to establish connection with the station.

Station Name    :  CHOUSHI-8M
Frequency (T/R) :   8765.00 / 8965.00(kHz)  Comm Mode :ARQ
Comm Status     :  Connect  Send  Lock  Error  
Sending Volume  :  100(%)   ARQ Error : 0   ARQ Time : 0(sec)

Caps
1:File 2:Edit 3:Operate 4:Window 5:Station 6:System 7:WRU 8:HR 9:Over 10:Break

1996-11-15 14:28 (JST)

Figure 5-5 Communication status display

"Connect" appears in inverse video on the Comm Status line when
an acknowledge signal from the station called is detected. (In the
ARQ mode connection may be delayed due to signal condition. In
the FEC mode, however, "Connect" appears in inverse video a few
seconds later since the acknowledge signal is not required.)
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5.3 Transmitting a File from a Floppy Disk or the Text Screen

You may send a file from a floppy disk or the Text Screen as fol-
lows after calling a station.

From a Floppy Disk

1. Press function key [F3] and then the [3] key.

2. The Send screen appears.

Send File

File Name          Size  Date & Time

LOG FILE            1k 1996/11/15 14:23
TELEX               1k 1996/11/15 20:32
NBDP                1k 1996/11/15 20:31
DO-5                1k 1996/11/15 20:30

To select : ENTER  To view : SPACE  To quit : ESC 

Figure 5-6 Send file screen

3. Select the file you wish to send. Then, press the [Enter] key to
transmit the file.

From the text screen 1 or 2

1. Prepare a message at the text screen 1 or 2 (working area 1 or
2).

2. Press function key [F3] and then the [3] key.

3. Press the [Enter] key to transmit the file.

Stopping Transmission

1. Press function key [F3] and then the [4] key.

2. Send Canceled appears on the screen. Transmission is stopped
but the line is still connected.

If the receiving station (IRS) reverses the communications direc-
tion while the sending station is transmitting a file, as many as six
characters from the end of the message may not be transmitted,
although they are displayed on the sending station’s LCD.
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5.4 Selecting Receive Mode

1. Press function key [F3] and then the [6] key.

2. Select receive mode;

AUTO: Automatic operation in ARQ and FEC

ARQ: International radiotelex ARQ mode

FEC: International radiotelex FEC mode

3. Press the [Enter] key. The reception mode appears on the screen.

All received (and transmitted) messages are saved to a floppy disk
when "Tx/Rx Msg Save" is ON in the System menu. The file is
named as follows.

96   12   13   0   0.   X   X   X

Year datemonth Serial number from 000

When "Tx/Rx Msg Save" is OFF in the System menu, all mes-
sages are displayed on the screen. To scroll the display, press [Pg
Up] or [Pg Dn] while pressing down the [Fn] key. These message
disappear when the power turns off.

5.5 ARQ Mode Operation

In ARQ operation one station (information sending station) sends
data to another in block by block, then listens the acknowledge
signal between blocks from the information receiving station which
requests either the next block or retransmission of the last block if
there is error. The request may be repeated up to 32 times, until the
complete block is received free of error.

1. Press function key [F3] followed by the [1] key. The Call Sta-
tion menu appears.

Caps
Station Name    :  CHOUSHI-8M
Frequency (T/R) :   8765.00 / 8965.00(kHz)  Comm Mode :AQW
Comm Status     :  Connect Send Lock Error  Mark  Space
Sending Volume  :  100(%)   ARQ Error : 0   ARQ Time : 0(sec)

1996-11-15 14:41:09(JST)

Call Station

Station List

ABC-4M
ABC-6M
ABC-12M
ABC-8M
FURUNO

Station Setup

Station  : ABC-4M
ID Code  : 45678
Mode     : ARQ FEC
CH/Table : Channel Scantable
Num/Table:

1:File 2:Edit 3:Operate 4:Window 5:Station 6:System 7:WRU 8:HR 9:Over 10:Break

Figure 5-7 Call Station menu
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2. Select a station. (Station must be registered for the ARQ mode).
Press the [Enter] key. The message "Calling Station" appears.

If the message "Station calling suspended. Check radio and
interconnections. Press any key to escape." appears, check both
radio's power and interconnections between the radio and the
DP-6.

3. When an acknowledge signal is detected, "Connect" appears
in inverse video on the communication status display (see next
page).

Note:  If signal conditions are poor, connection may take a
while. If the line could not be connected in one minute, calling
stops and "Calling failed" appears. Try step 2 again one minute
later. Should signal conditions worsen during message
transmission, "Error" appears in inverse video and 30 seconds
later the line is disconnected.

4. Transmit message by one of the following methods;

Send a file from a floppy disk

a) Press function key [F7] (WRU) to receive the answerback
code of the other station. Verify that the code from the sta-
tion called is correct.

b) Press function key [F8] (HR) to transmit your own identity
(answerback code).

c) Press function key [F3] and then the [3] key to display the
Send screen. Select file to send and press the [Enter] key.
Send appears in inverse video while the file is being trans-
mitted.

Send File

  Filename  
<Parent Directory>
00FOX   .MES
ASCII   .TXT
BEEP    .EXE
DPX     .AUT
DPX     .BAT
DPX     .BSC
DPX     .CNL
 29 Files exist     247271424 bytes free

  Size  

95
613

28854
1830
349

28000
1000

12:24
08:07
16:15
10:36
10:02
13:54
17:11
10:02

  Data & Time 
96-11-15
96-11-15
96-11-15
96-11-15
96-11-15
96-11-15
96-11-15
96-11-15

To select:ENTER   To view:SPACE   To quit:ESC

Figure 5-8 Send file screen

Sending volume (percentage of message transmitted, counts
upward as the message is being transmitted), ARQ error count
and ARQ transmission time appear on the display.
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Station Name    :  CHOUSHI-8M
Frequency (T/R) :   8765.00 / 8965.00(kHz)  Comm Mode :ARQ
Comm Status     :  Connect  Send  Lock  Error  
Sending Volume  :  100(%)   ARQ Error : 0   ARQ Time : 0(sec)

1996-11-15 14:28  (JST) Caps
1:File 2:Edit 3:Operate 4:Window 5:Station 6:System 7:WRU 8:HR 9:Over 10:Break

Figure 5-9 Communication status display

Type a message from keyboard

After exchanging answerback code by the function key [F7]
(WRU) and [F8] (HR), type your message directly from the
keyboard.

5. To change direction of traffic, press either function key [F9]
(OVER), or [+] and [?]. Then, the other station becomes the
information sending station, your station the information re-
ceiving station.

6. Receive a message from the sending station, if any.

7. After completion of communication, press function key [F7]
(WRU) key to receive the answerback code of the other station
and then press function key [F8] (HR) key to transmit your
own answerback code.

8. Press function key [F10] (BREAK) to disconnect the line.

5.6 FEC Mode Operation

The FEC method of error correction is used when there is more
than one receiving station, and no replies are required by the other
station. Each message is sent twice, the characters of the first mes-
sage interleaved with those of the second. The receiving station
thus has two chances to receive each character correctly. If both
characters are in error, an asterisk (*) is printed.

1. Press function key [F3].

2. Press the [1] key to display the Call Station menu.

You can select scan group by scan table.

3. Select a station which is registered for the FEC mode. Press
the [Enter] key. CONNECT lights in inverse video.

4. Transmit message from a floppy disk as follows.

Press function key [F3] and the [2] key to open the Send screen.
Select file to send and press the [Enter] key.

5. After the message is transmitted, press function key [F10]
(BREAK) to disconnect the line.
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5.7 Communication Example

This section shows how to register your station with a coast station
(Singapore), in order to connect with a land line and send mes-
sages to other stations.

Contact the coast station following the procedure on page 5-3. Then,
register your station's name, call sign, answerback code and selcall
number and AAIC (Accounting Authority Identification Code) with
the coast station.

You can call the Singapore coast station on ITU channels 809, 821
or 1201 (other channels may also be used). Use communication
mode ARQ. The Singapore coast station ID no. is 4620.

Registration procedure

1. Call Singapore coast station following the procedure on page
5-3.

2. Singapore requests your AAIC.

3. Type your AAIC.

4. Singapore asks for your callsign. Send your station's name,
callsign, answerback code and selcall number.

5. Singapore sends time required to register your station.

6. Transmit end code.

9VG SERADIO RS
12345 FURUNO X
54321 ABCDE J
9VG SERADIO RS
MOM
F
UGOX DE 9VG RGR GA X X PSE SUPPLY YOUR AAIC HW +?

OPR +
AAIC  AA01 +?
RGR PSE GIVE YOUR SHIP NAME CALLSGI CALLSIGN HW +?
I INTRODUCE MY INFO LATER
PLS AGAIN
AAAAAA
CS-  1111
ANSWERBACK CODE- ccccc cccc c
AAIC- 9999
SELCALL- 56789
OK HW +?
PSE BE SURE W ICH AAIC CFM PSE HW +?
bb01 SO + +?
RGR PSE OFF TX X HERE EEE CALL BACK 2MINS TIME X HERE WILL
INPUT YOUR DATA
CU BI HW +?
OK TKS BI BI

Exchange answerback codes

Singapore requests your AAIC.

Singapore requests your station's name and callsign.

Enter your stations name, callsign, answerback,
code and selcall number.

Time required to reigister your station

Call operator.
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Transmitting message directly (DIRTLX)

The procedure which follows shows how to transmit a Telex mes-
sage directly to a station.

1. Execute "Calling a Station" on page 5-3.

2. After GA+ and DIRTLX appear on your display, type Receiv-
ing station's Telex number.

3. Singapore coast station sends its Telex number. Type receiving
station's answerback code.

4. Type MSG+?

5. Type your message.

6. Type WRU. Receiving station and your station mutually ex-
change answerback codes automatically.

7. Type KKKK (end code) at end of message. Your answerback
code, receiving station's Telex number and communication time
appear on your display.

8. Receiving station sends GA+?.

To send another message by DIRTLX, start at step 2. To finish,
type BRK+

9VG SERADIO RS 55908 UGOX X
GA +?
DIRTLX07205644325 = +
TRY AGAIN OR USE 'OPR'
GA +?
DIRTLEX07205644325 +
MOM07205644325 +
5644325FURUNO J
MSG +?
12345 FURUNO J

TO FURUNO
THIS IS A TEST MESSAGE FROM ab cdefgh ijkl  IN KOBE.

WRU
5644325FURUNO J +?
54321 ABCD N
KKKK
55908 UGOX X
9VG SERADIO RS
TIME: 29. 5. 96 7:49
SHIP: 555908 UGOX X
SUBSCR:07205644325 +
DURATION:1.4MIN
GA +?
BRK +

Exchange answerback codes
After GA+ appears type Receiving station's
Telex number.

Receiving station's Telex no.

If there is a mistake in the number coast station
asks you to reenter number.

Type receiving station's answerback code.

Prepare to send message.

Type message.

BRK + disconnects the communication line.
To send another message type DIRTLX instead of BRK +.

End code. Your ship's answerback code, receiving station's
Telex no. and communication time appear.
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Table of Abbreviations

noitaiverbbA noitseuQ ecivdArorewsnA

ARQ ?noitatsruoyemanehtsitahW .····sinoitatsymfoemanehT

CRQ ehteraesirpretneetavirptahwyB
noitatsruoyrofsegrahcrofstnuocca

?delttes

deltteseranoitatsymrofstnuoccaehT
.····esirpretneetavirpehtyb

URQ ?emrofgnihtynauoyevaH .uoyrofgnihtonevahI

VRQ ?ydaeruoyerA .ydaermaI

XRQ ?niagaemllacuoylliwnehW no[sruoh····taniagauoyllaclliwI
.]zHk····

JSQ ·otdetcellocebotegrahcehtsitahW
?egrahclanretniruoygnidulcni···

····otdetcellocebotegrahcehT
····siegrahclanretniymgnidulcni

.····snarf

LSQ ?tpieceregdelwonkcauoynaC .tpieceregdelwonkcanacI

XSQ no]ngisllac[····otnetsiluoylliW
?zHk····

no]ngisllac[····otgninetsilmaI
.zHk····

ATQ ?····rebmunegassemlecnacIllahS ····rebmunegassemlecnaC

CTQ otuoyevahsegassemynamwoH
?dnes

.uoyrofegassem····evahI

UTQ sinoitatsruoysruohehteratahW
?nepo

····ot····morfneposinoitatsyM
.sruoh

noitaiverbbA noitinifeD

KB .ssergorpnoissimsnartatpurretniotdesulangiS

MFC mrifnoC

ED "····morF"

K .timsnartotnoitativnI

LIN .uoyotdnesotgnihtonevahI

WN woN

ESP esaelP

R devieceR

FER .····otecnerefeR

CVS .margeletecivresagnitacidnixiferP

Command an Abbreviation

dnammoC dnammoC dnammoC dnammoC dnammoC noitcnuF noitcnuF noitcnuF noitcnuF noitcnuF

+MGT .margeletoidarasiegassemgniwollofehttahtetacidnioT

+GSM .dlehegassemynayletaidemmidetcennocebotsdeennoitatspihsehttahtetacidnioT

+RPO .rotarepollaC

+GRU .egassemssertsiddnaycnegru,ytefaS

+DEM .ecivdalacidemtseuqeR

+TSET .noitatspihsehtgnikcehcrofegassemtsetadnesotnoitatstsaoctseuqeR

+KRB .noitatstsaocehthtiwnoitcennocehtraelcoT

noitaiverbbA

+AG .dnammocruoytimsnarT.ydaermaI

MOM .tnemomatiaW

+GSM .erohsehtmorfsegassemgnidneptseuqeR

NNNNroKKKK .egassemaetanimreT
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5.8 Timer Operation

A built-in timer permits automatic transmission and reception of
telex messages.

Enabling Timer Operation

1. Press function key [F3] to display the Operate menu.

2. Press the [7] key to display the Timer Operation List.

3. Select the operation (name) you wish to execute. Press the [En-
ter] key. An asterisk appears beside the operation selected and
"T. Op" appears in inverse video on the communication status
display. If a file from a floppy disk is to be sent, be sure the
floppy disk containing the file is inserted in the drive.

*1
 2
 3
 OP4
 OP5

Timer Operation List

Figure 5-10 Timer operation list

4. Select another operation (name) if desired.

5. Press the [Esc] key.

When the predetermined time comes, the DP-6 automatically sends
or receives messages. The results of timer operation are displayed
as either OK or NG (No Good) on the Timer Operation List.

*1
 2
*3
*OP4
*OP5

OK

OK
OK
NG

Timer Operation List

Figure 5-11 Timer operation list

Stopping Timer Operation

1. Press function key [F3].

2. Press the [7] key.

3. Select the operation (name) which has asterisk attached to it
and then press the [Enter] key. Remove all asterisks to cancel
all timer programs.
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5.9 Scanning

Radio equipment scans a group of operator-selected frequencies
(channels), and stops scanning when an incoming signal is received.

1. Press function key [F3] and then the [5] key. The Scanning
Group List appears on the screen.
You can confirm the scan channel by [↑ ] key or [↓ ] key while
pressing the [Shift] key.

*1
 2
*3

Scanning Group List

Figure 5-12 Scanning group list

2. Select a scan group and press the [Enter] key.

3. The scanning starts and the indication "Scan" appears in in-
verse video on the communication status display. (The name
of the scan group appears at the "Station Name".)

Station Name    :  SAITO-1            Print  Scan  T.Op  HT  Scra
Frequency (T/R) :  8344.00 / 8705.00(kHz)  Comm Mode : CW
Comm Status     :  Connect Send Lock Error  
Sending Volume  :  100(%)   ARQ Error : 0   ARQ Time : 0(sec)

1996-11-15 02:01  (JST)
1:File 2:Edit 3:Operate 4:Window 5:Station 6:System 7:WRU 8:HR 9:Over 10:Break

Figure 5-13 Communication status display

4. To stop scanning, press function key [F3] and then the [5] key.

5.10 Communication Buffer

The communication buffer is a temporal memory which stores trans-
mitting messages or receiving messages. To display the contents
of the comunication buffer;

1.   Escape from the communication display.

2.   Press the [PgDn] or [PgUp] key. The contens of the communi-
cation buffer are displayed.

To print them, press [Ctrl] and [P] keys simultaneously. To erase
them from the screen, press [PgDn] key again.
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6. WINDOW MENU

The Window menu allows you to display one of the following to-
gether with the current screen:

1) Navigation data

2) Calendar

3) Remote controller screen (Remote A or Remote B)

4) Distress frequencies

1: Display NMEA Data

2: Calendar

3: Remote A (TX/RX)
4: Remote B (DSC)

5: Distress Frequency Table

Window

Figure 6-1 Window menu

6.1 Window Menu Description

Display NMEA Data

With connection of a navaid and appropriate sensors which output
nav data in IEC1162 (NMEA0183) format, position, speed, water
temperature, depth and heading can be displayed. Press function
key [F4] and the [1] key. Asterisks appear where there is no data.

Lat/Lon

NMEA

Latitude Longitude

LA
LC
NNSS
DECCA
GPS

**°**.*** N       ***°**.*** E
**°**.*** N       ***°**.*** E
**°**.*** N       ***°**.*** E
**°**.*** N       ***°**.*** E
**°**.*** N       ***°**.*** E

*.* (  °C )
Depth

*.* ( Ft )

Temperature

*.* (Knot)
Heading

*.* (  °    )
Ship's Speed

Figure 6-2 NMEA data display
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Calendar

The Calendar menu displays the calendar of any combination of
month and year you desire. Press function key [F4] and the [2]
key. To change year or month, select it by the []/[ ] keys and
change by the [ ]/[ ] keys.

Year  :         1996   
Calendar

Month :            11 

Sun   Mon   Tue   Wed   Thu   Fri   Sat
                                1     2
( 3)    4     5     6     7     8     9
(10)   11    12    13    14    15    16
(17)   18    19    20    21    22    23
(24)   25    26    27    28    29    30

Figure 6-3 Calendar

Remote A, Remote B

This menu permits remote control of a FURUNO transceiver, re-
ceiver or transmitter connected to Remote A or Remote B termi-
nal. Press function key [F4] and the [3] key (Remote A) or the [4]
key (Remote B).

MIF>
Remote

Figure 6-4 Remote screen

Distress Frequency Table

This menu displays all current distress frequencies. Press function
key [F4] and the [5] key.

Distress Frequencies

Telepone (kHz) : 2182.0  4125.0  6215.0  8291.0  12290.0  16420.0

NBDP     (kHz) : 2174.5  4177.5  6268.0  8376.5  12520.0  16695.0

DSC      (kHz) : 2187.5  4207.5  6312.0  8414.5  12577.0  16804.5

Figure 6-5 Distress frequency table
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7. MARITEX OPERATION

This chapter provides an overview to the MARITEX system. For
detailed information, consult your MARITEX Traffic Manual.

7.1 What is MARITEX?

MARITEX, an acronym meaning MARItime TEleX, is a world-
wide, round-the-clock, fully automatic and computerized network
for maritime radiotelex. The MARITEX system is operated jointly
by the Telecom Administrations of Denmark, Finland, Iceland,
Norway, and Sweden. The system consists of the Central Com-
puter System in Gothenburg, Sweden, run with two high technol-
ogy computers, and sub-stations in Scandinavia, Panama, Manila,
and Argentina. The Central System does all the message switching
and co-ordinates the sub-station resources.

STORE-AND-
FORWARD

DIRECT
DIALING

MULTI-
ADDRESS

INTERNATIONAL
TELEX NETWORK

INTERNATIONAL
TELEPHONE
NETWORK

SEMI-FAX

MARITEX
CENTRAL
SYSTEM

SYSTEM
CONTROL

SUB-STATION
PANAMA

SUB-STATION
SCANDINAVIA

SUB-STATION
MANILA

SUB-STATION
ARGENTINA

PARTICIPATING
SHIPSREMOTE-CONTROLLED

RADIO CIRCUITS

Figure 7-1 MARITEX system and services
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MARITEX Services

MARITEX provides four main services to MARITEX subscrib-
ers:

• Store-and-forward telex

• Direct dialing

• Multi address

• Semi-fax

Note: MARITEX provides both shore-to-ship and ship-to-shore
services. This manual, however, describes only the ship-to-shore
communication procedures.

7.2 Preparations for Transmission

To transmit a message in the MARITEX system, you will need to
register three items:

• Answerback code

• Scan groups

• Station names

 Registering Answerback Code

MARITEX assigns a Telex number to all MARITEX subscribers.
This number functions as an answerback code. An answerback code
contains the following:

OOOOO  SHIP  X

OOOOO: MARITEX-assigned five-digit Telex code
SHIP:      Ship name
X:            For shipboard station, normally X is entered.

The procedure for registering answerback code is the same as which
appears on page 3-1. If an answerback code was registered before
the commissioning of the MARITEX station a new answerback
code must be entered. To enter new answerback code, contact
FURUNO or authorized FURUNO agent or dealer.
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Registering Scan Groups

The Central System emits a free-signal to indicate a MARITEX
radio channel is in idle condition and available for ship-to-shore
calls. The free-signal is detected and recognized by the shipboard
equipment as a permission to start the transmission. Then, the ship-
board operator initiates a call.

You can scan search for the free-signal automatically by register-
ing MARITEX radio channels in scan group(s). The procedure for
registering scan groups for MARITEX use is the same as that which
appears on page 3-7.

1. Press function key [F5] to display the Station menu.

2. Press the [3] key to select Scan Entry. The screen should look
something like Figure 7-2.

Create
Change

Scan Entry

Scanning Group List

Scanning Set Up

Group Name     : 
Ch Dwell Time  : 4.5 sec (2.7-4.5 sec)
Mode    : AUTO ARQ FEC
Auto Search    : OFF ON

No    Channel    Rx Freq    Tx Freq    Pass/Scan
1
2
3
4
5
6

Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan▼

Figure 7-2 Scan entry screen

3. If Create is not underlined, press [], [ ] and the [Enter] key
to underline it.

4. Group Name appears in inverse video, meaning you can enter
scan group name. Enter scan group name; for example,
MARITEX-A.

5. Press the [] key to advance the cursor to Ch Dwell Time. The
dwell times is the time in seconds the receiver waits on each
channel before it selects the next channel. The default setting
is 2.7 seconds. Change the setting if necessary.
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6. Press the [] key to advance the cursor to Mode. Select the
communication mode, AUTO, ARQ or FEC.

7. Press the [] key to advance the cursor to Auto Search. Turn
Auto Search ON or OFF;

Auto Search ON: Radio stops scanning when it finds the stron-
gest (S/N ratio) free-signal frequency. Use it where signal propa-
gation in poor.

Auto Search OFF: Scanning starts and stops with the first-
received free-signal frequency. Normally, use this position.

8. Press [ ] to place the cursor on the No. 1 line. Enter channel or
user channel. See the table on the next page for MARITEX
radio channel information. Then, press the [] key to select
"Scan".

9. Press [ ] to advance the cursor to the No. 2 line. Enter channel
number. Repeat this procedure for other channels, up to 20.

10. Press the [Enter] key.

11. Press the [Enter] key again to register scan group.

Create
Change

Scan Entry

Scanning Group List

Scanning Set Up

Group Name     : MARITEX-A
Ch Dwell Time  : 4.5 sec (2.7-4.5 sec)
Mode    : AUTO ARQ FEC
Auto Search    : OFF ON

No    Channel    Rx Freq    Tx Freq    Pass/Scan
1      1 
2      2
3      3
4      4
5      5
6      6

4268.60
6460.00
8556.00
12818.00
17024.00
22607.00

4203.50
6302.00
8398.50
12563.50
16790.50
22352.00

Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan
Pass/Scan▼

MARITEX-A

Figure 7-3 Scan entry screen

To enter another scan group, select Create and then press the [En-
ter] key. Repeat steps 3 – 9.
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Table 7-1 MARITEX Channel

ITU
Channel

MARITEX
No.

Coast Station
TX (kHz)

Ship Station Tx
(kHz) Location

UP
UP
UP

UP
4009
4014

UP
6001
6019

UP
8007
8024

UP
12006
12024

UP
16014
16064
16057

UP
22007
22032

8017
12008
16033
22031

4006
8040

12050
16188
22040
16164

6001
8028
12028
16028

8027
12067

4019
6031
8030
12088
16096

A7
B7
D7

A1
B1
C1

A2
B2
C2

A3
B3
C3

A4
B4
C4

A5
B5
C5
C7

A6
B6
C6

D3
D4
D5
D6

F1
F3
F4
F5
F6
F7

G3
G4
G5
G6

G1
G2

2423.5
2716.0
1905.0

4268.6
4214.5
4216.5

6460.0
6314.5
6323.0

8556.0
8419.5
8428.0

12818.0
12582.0
12591.0

17024.0
16813.5
16838.0
16834.5

22607.3
22379.5
22392.0

8424.5
12583.0
16822.5
22391.5

4213.0
8436.0

12604.0
16900.0
22396.0
16888.0

6314.5
8430.0

12593.0
16820.0

8429.5
12612.5

4219.0
6329.0
8431.0

12622.5
16854.0

3267.5
2477.0
2222.0

4203.5
4176.5
4179.0

6302.0
6263.0
6272.0

8398.5
8379.5
8388.0

12563.5
12479.5
12488.5

16790.5
16690.0
16715.0
16711.5

22352.0
22287.5
22300.0

8384.5
12480.5
16699.5
22299.5

4175.0
8396.0

12501.5
16782.0
22304.0
16770.0

6263.0
8390.0

12490.5
16697.0

8389.5
12510.0

4181.5
6283.0
8391.0

12520.5
16731.0

SWEDEN
SWEDEN
SWEDEN

SWEDEN
SWEDEN
SWEDEN

SWEDEN
SWEDEN
SWEDEN

SWEDEN
SWEDEN
SWEDEN

SWEDEN
SWEDEN
SWEDEN

SWEDEN
SWEDEN
SWEDEN
SWEDEN

SWEDEN
SWEDEN
SWEDEN

PANAMA
PANAMA
PANAMA
PANAMA

ARGENTINA
ARGENTINA
ARGENTINA
ARGENTINA
ARGENTINA
ARGENTINA

SAN FRANCISCO
SAN FRANCISCO
SAN FRANCISCO
SAN FRANCISCO

NEW ORLEANS
NEW ORLEANS

CHINA/GUANGZHOU
CHINA/GUANGZHOU
CHINA/GUANGZHOU
CHINA/GUANGZHOU
CHINA/GUANGZHOU

Valid on 1997.

UP means no ITU channel assigned. You can use register these as user channels.
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Registering Stations

The next step is to enter station name. The procedure is the same
as the procedure shown on page 3-3. The station list provides ab-
breviated dialing with storage for up to 50 stations.

1. Press function key [F5] and the [1] key. The Station Entry screen
appears.

Station Entry

Create
Change

Station List

Station Set Up

Station  : 
ID Code  :
Mode     : ARQ FEC DIRC
CH/Table : Channel ScanTable
Num/Table:

Figure 7-4 Station entry screen

2. If Create is not underlined, press [], [ ] and the [Enter] key
to underline it.

3. The cursor is on the Station line. Enter station name, using up
to 20 characters.

4. Press the [] key to go to the ID Code line. Enter station ID
code; the coast station selective call number common to all
stations is 2950.

5. Press the [] key to go to the Mode line. The MARITEX sys-
tem uses the ARQ mode.

6. Select ScanTable on the CH/Table line.

7. Press [ ] to go to Num/Table.
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8. Press the [] key to display the Scanning Group List.

 Scanning Group List 

MARITEX-A

MARITEX-B

MARITEX-C

MARITEX-D

MARITEX-E

MARITEX-F

Figure 7-5 Scanning group list (example)

9. Select scan group.

10. Press the [Enter] key. To enter another station name, repeat the
above procedure from step 2.

Note:  To establish the connection with a MARITEX station, the
receiving frequencies in the scan group registered are scanned to
detect a free signal from the station. If the free signal is detected, a
message will be automatically transmitted to the station.
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7.3 Preparing Programs for Automatic Message
      Transmission

This section shows you how to prepare the programs necessary for
automatic message transmission. The programs, which you can
save to a floppy disk for future use, enable unattended automatic
transmission.

The program for automatic transmission is called a macrofile. You
will need several types of macrofiles depending on the MARITEX
service to be utilized.

Commands

The tables which follow describe the commands for automatic trans-
mission.

Table 7-2 describes the commands processed by the DP-6.

 Table 7-2 Commands processed by the DP-6

Command
(prefixed with @)

Parameter Content

CALL S: Station Name
I: ID

Calling station name and ID on assigned
parameter

FREE (support
command for CALL)

Two digits
0?99 min.

Free-signal searching time according to
assigned parameter (default setting: 10 min.)

RETRY (support
command for CALL)

Two digits
0?99 min.

Calling according to assigned parameter
(default setting: 10 min.)

CASE Text For receving a message (designanted by
parameter) transmitted by coast station

TIMEOUT (support
command for CASE)

Two digits
0?99 min.

Time alloted for reception of message by
CASE command

SEND Text Text transmitted according to assigned
parameters

B:file name Send a file from floppy disk

WRU
HR
OVER
BREAK

None Function keys [F7] ? [F10]

DISPLAY Text Text of message appears

INPUT None Waiting for keyboard input
Transmit keyboard input message
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After reception of GA+?, enter appropriate short-code command.
Table 7-3 shows the commands processed by MARITEX stations.

Table 7-3 MARITEX short-code commands

dnammoC esU

+.....XLT
+.....XLTRID

+.....ITLUM
+.....XAF

+GSM
+NNNN

+KRB

xeleTdrawrof-dna-erotS
xeleTgnilaidtceriD

sserdda-itluM
xaf-imeS

erohsmorfsegassemgnidneptseuqeR
egassemetanimreT

tiucricoidarehtraelC

Other MARITEX short-code commands are as below.

Table 7-4 Other MARITEX short-code commands

dnammoC esU

+SOP
+GRU
+DEM

+RTL
+TST
+KRM

stropernoitisoppihsfonoissimsnarT
segassemssertsiddnaycnegru,ytefaS

ecivdalacidemtseuqeR
ediwdlrowsnoitanitsedotretneCsnoitarepOehtmorfdeliamsrettelXETIRAMroF

sretcarahcxeleTllafognitsisnocegassemtsetadnesotXETIRAMottseuqeR
etunimenorofenotkramsuounitnocadnesotXETIRAMottseuqeR

Note:  For other supporting and facility commands, consult the
MARITEX Traffic Manual.
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Store-and-Forward Telex

The following is the sequence of events in transmission of Telex
message in MARITEX.

1. Shipboard station sends message to MARITEX coast station.

2. MARITEX coast station stores message in memory buffer.

3. Shipboard station and MARITEX coast station clear the radio
circuit.

4. MARITEX station sends message to subscriber designated.

.oN erudecorP yalpsiD skrameR

1 .XETIRAMllaC sraeppaTCENNOC
oedivesrevnini

.)sdnuosllebdna(

;dnuoflangis-eerF
.ydaertiucricoidar

2 .langisURWtimsnarT
XXETIRAM

XPIHSXXX62
?+AG

ytitnedilaitinI
neewtebegnahcxe

dnanoitatstsaoc
noitatsdraobpihs

3 .rebmunxeleTs'rebircsbusniyeK
54321)gnoKgnoH(:elpmaxE

+54321208XLT ?+GSM tratsottseuqeR
noissimsnartegassem

4 .eliftimsnarT noissimsnartegasseM

5 ,detelpmocsinoissimsnartnehW
.NNNNepyt

XPIHSXXX62
SXETIRAM

NOITARUD
ETAD
?+AG

ruoytimsnarT
.edockcabrewsna
XETIRAMevieceR
kcabrewsnas'noitats

etaddnaemitxT.edoc
.6-PDnoraeppa

6 otdnammocKAERBtimsnarT
.tiucricoidarraelc
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Preparing a macrofile for store-and-forward Telex

You will need a macrofile to enable automatic message transmis-
sion on store-and-forward Telex. After preparing it, save it to the
hard disk or a floppy disk for future use.

1. Press function key [F1] to display the File menu.

2. Press the [1] key.

3. Prepare macrofile.

The figure below shows the minimum information required to send
a store-and-forward Telex message in MARITEX.

 < [1] UNTITLED1 > 

@FREE 10

@CALL S: MARITEX

@WRU

@CASE GA+?

@SEND TLX80212345+

@CASE MSG+?

@SEND B:ABC

@SEND NNNN

@CASE GA+?

@SEND BRK+

1

2

3

4

5

1 Free-signal search time (10 minutes
2 Station name (Example: MARITEX)
       Who are you?
       Station identity exchange
3 Subscriber's Telex number (in example, 802 is country
     code of Hong Kong) for store-and-forward Telex
4 Location and name of file message 
5 Request for termination of message

Figure 7-6 Example macrofile for store-and-forward Telex

4. Press function key [F1] to display the File menu.
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5. Press the [5] key. The Save prompt appears on the display.

  close Text  

Saving File Name

(Untitled 1)
No

Yes

 Figure 7-7 Save prompt

 6. Press the [Enter] key and enter a file name as follows.

      OOOOOOOO.MCR
              ↑               ↑
      File Name        Extension Name
      (max. 8 characters)

7. Press the [Enter] key.
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Macrofile for Direct Dialing

The direct dialing features allows you to contact a land subscriber
via MARITEX. Below is an example of a macrofile for direct dial-
ing

@FREE 15

@CALL S: MARITEX

@WRU

@CASE GA+?

@SEND DIRTLX725644325+

@CASE MSG+?

@SEND B:ABC

@SEND NNNN

@CASE GA+?

@SEND BRK+

1

2

3

4

5

1 Free-signal search time (15 minutes
2 Station name (Example: MARITEX)
       Who are you?
       Station identity exchange
3 Subscriber's Telex number (in example, 72 is country
     code of JAPAN) for direct dialing mode
4 Location and name of file message
5 Request for termination of message

 Figure 7-8 Example macrofile for direct dialing
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Procedure for direct dialing

.oN erudecorP yalpsiD skrameR

1 .XETIRAMllaC sraeppaTCENNOC
dna(oedivesrevnini

.)sdnuoslleb

;dnuoflangis-eerF
.ydaertiucricoidar

2 .langisURWtimsnarT
XXETIRAM

XPIHSXXX62
?+AG

ytitnedilaitinI
neewtebegnahcxe

dnanoitatstsaoc
noitatsdraobpihs

3 .rebmunxeleTs'rebircsbusniyeK
523446527)napaJ(:elpmaxE

+523446527XLTRID

02:21
MOM

JONURUF5234465
?+GSM

tratsottseuqeR
noissimsnartegassem

4 tupniroelifderaperptimsnarT
hguorhtyllaunamegassem

.draobyek

noissimsnartegasseM

5 ,detelpmocsinoissimsnartnehW
.NNNNepyt

XPIHSXXX62
JONURUF5234465

NOITARUD
ETAD
?+AG

ruoytimsnarT
.edockcabrewsna
XETIRAMevieceR
kcabrewsnas'noitats

dnaemitxT.edoc
.6-PDnoraeppaetad

6 otdnammocKAERBtimsnarT
.tiucricoidarraelc
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Macrofile for Multi Address

The figure which follows shows an example of a macrofile for
multi address use.

@FREE 15

@CALL S: MARITEX

@WRU

@CASE GA+?

@SEND MULTI+

@CASE num+?

@SEND 725644325

@SEND 80255785

@SEND 5412345

@SEND 42124567

@CASE MSG+?

@SEND B:ABC

@SEND NNNN

@CASE GA+?

@SEND BRK+

1

2

3

4

5

 Figure 7-9 Example of macrofile for use in multi address
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Macrofile for Semi-fax

In the Semi-fax option, MARITEX converts ship-to-shore direc-
tion telex message to facsimile and retransmits it via the telephone
network.

The figure below shows an example of a macrofile for Semi-fax.
The macrofile for Semi-fax is the same as the macrofile for store-
and-forward and direct dialing except for the FAX command.

@FREE 15

@CALL S: MARITEX

@WRU

@CASE GA+?

@SEND FAX802123456+

@CASE MSG+?

@SEND B:ABC

@SEND NNNN

@CASE GA+?

@SEND BRK+

1

2

3

4

5

 Figure 7-10 Example of macrofile for semi-fax
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7.4 Transmitting in MARITEX System

This section describes how to transmit a Telex message in
MARITEX.

Basic Procedure

1. Register answerback code (Telex number assigned by
MARITEX).

2. Register MARITEX frequency and channel to scan group.

3. Register station name including scan group name.

4. Retrieve appropriate macrofile. Include station name and mes-
sage file name. Type message and save file to memory.

5. Open macro operation menu and select macrofile. (See next
page for details.) Your message will be transmitted automati-
cally. Below is the sequence of automatic message transmis-
sion in MARITEX.

1) Search for free-signal

2) Call MARITEX station on MARITEX radio channel.

3) After connection is established, identity exchange

4) Transmission of service category and subscriber’s address

5) Transmission of message

6) Transmission of termination of message signal

7) Identity exchange

8) Clearing of radio circuit
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Actual Transmission

1. Press function key [F3] to display the Operate menu.

1: Call Station

3: File to Send
4: Cancel Sending

5: Scan (Start/Stop)

6: Manual Reception

7: Timer Operation

8: High Tension ON

9: Manual Calling
0: Set Frequency

Operate

2: Macro Operation

Figure 7-11 Operate menu

2. Press the [2] key. The Call Macro screen appears.

 Call Macro 

                                

MARITEX1.MCR      95     1996-12-13  11:20
MARITEX2.MCR      95     1996-12-11  12:20

File Count: 2     Memory:2K Used     98K Available       

Name

Date

Filename       Size       Date & Time             

Figure 7-12 Call macro screen

3. Select desired macrofile and press the [Enter] key.

4. Press the [Enter] key to confirm the macrofile selected. The
Wait for Free Signal indication appears. Your message will be
transmitted automatically.
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8. MAINTENANCE AND
TROUBLESHOOTING

Do not work inside the
equipment unless totally
familiar with electrical
circuits.

Hazardous voltage which can
cause electrical shock, burn or 
serious injury exists inside the 
equipment. 

WARNING

8.1 Maintenance

Regular maintenance is important for good performance. A regu-
lar maintenance program should be established and should at least
include the following:

Cleaning the Equipment

Wipe of accumulated dust from the equipment with a soft cloth.
An anti-static cleaner may be used to clean the screen of the termi-
nal unit. Do not use commercial cleaners to clean the equipment.
They can remove paint and markings.

Connectors and Earth Connection

Periodically check the connectors for proper seating and the earth
connection for rust. Remove rust to maintain a good ground sys-
tem.

Floppy Disk Drive

Clean the floppy disk drive head regularly to prevent erasure of
information stored on disks.
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8.2 Simple Troubleshooting

Power Supply

If the power cannot be applied (power lamp on the main unit does
not light):

• Check for loosened power cable connector on the rear or bot-
tom of units. Check that the ship's mains main switch is turned
on. Confirm that power is present at the connector (pin #1:(+),
pin #2: (-)).

tinU egatloVtupnI

tinuniaM CDV42

tinulanimreT CDV42

• Check if the breaker on the rear panel of the terminal unit has
tripped. If it has tripped, push it in to reset the equipment.

8.3 Diagnostic Tests

Self Test

1. Press function key [F6] to display the System menu.

System
Setup

Slave Delay
BK Timing PreTone
         PostTone
Mute Timing PreBK
           PostBK

Modem Output Level

MIF Tune
    Freeze
    AGC
    Emission

TX/RX MSG Save
Edit Before sending

Time System
Time & Date
Display Mode
Self Test

Lock  Change   Default

 5 msec (0- 50 msec)
10 msec (0-100 msec)
 0 msec (0- 20 msec)
 0 msec (0- 20 msec)
 0 msec (0- 20 msec)

0 dBm (-30 - +10 dBm)

OFF  O N
OFF  O N
OFF  O N
OFF  O N

OFF  O N
OFF  O N

OFF UTC SMT JST
1997/1/1/12:34:56
Normal Reverse

Figure 8-1 System menu

2. Select Change on the Setup line.

3. Select Self Test.
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4. Press the [Enter] key. The results of the self test are displayed a
short time later.

Self Test 

Terminal Unit Test : ver. 1.20         :OK
Main Unit Test     : ver. 1.17         :OK
Modem Unit Test    : ver. 1.18         :OK
Radio Unit Test    : ID xxxx*1         :OK
DSC Unit Test      : ID xxxx*1         :OK
Printer Unit Test*2: Printer not Ready :NG

*1: Actual ID numbers appears.
*2: OK replaces NG when printer is turned on and normal.

Figure 8-2 Self test results

If NG appears for any unit checked, try the self test again. If it
appears again, call for service.

Tone Test

1. Select Self Test on the System menu.

2. While pressing and holding down the [Shift] key, press the [ ]
key.

Tone Test  

1: Tone Test 1 (All Char)
2: Tone Test 2 (Fox)
3: Tone Test 3 (Beta)

4: Tone Test 4 (Mark)
5: Tone Test 5 (Space)
6: Tone Test 6 (BY)
    

Figure 8-3 Tone test

3. Select test and press the [Enter] key. You may stop a test at
anytime by pressing the [Enter] key.

Tone test 1 (All characters)

This test (continuously) checks for proper transmission of all fig-
ures, letters and codes. To conduct the test, call a station in the
ARQ or FEC modes. Execute the test, confirming that all charac-
ters are transmitted correctly. "Now testing Tone Test 1" appears
during the testing. Since the test is conducted continuously, you
may press [Esc] twice and [F10] key to stop the test and return to
the tone test menu.
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Station Name    :  
Frequency (T/R) :          /        (kHz)  Comm Mode : Auto
Comm Status     :  Connect Send Lock Error  Mark  Space

1:File 2:Edit 3:Operate 4:Window 5:Station 6:System 7:WRU 8:HR 9:Over 10:Break
1996-11-15 13:26:45.45    Caps Eng

Now Testing Tone Test 1 (All Char).

ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890-?:().,’=/+abcdefghijklmnopqrstuv
wxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ1234567890-?:().,’=/+abcdefghijklmnopqrstuv
wxyz

ABCDEFGHIJKLMNOPQRSTUVWXYZ

System

Lock  Change   DefaultSetup

Figure 8-4 All characters test screen

Tone test 2 (Fox)

This test (continuously) checks for proper transmission of the test
message THE QUICK BROWN FOX JUMPS OVER THE LAZY
DOG 0123456789. In order to conduct the test call a station over
the ARQ or FEC mode.

Tone test 3 (Beta)

You may check for proper transmission of the idle signal β. Call
up a station using the ARQ mode.

Tone test 4 (Mark)

This test outputs the mark signal through the LINE OUT terminal,
where a frequency counter may be connected, to confirm its fre-
quency (1615 Hz).

Tone test 5 (Space)

Tone test 5 verifies the space signal frequency (1785 Hz).

Tone test 6 (BY)

This test verifies the frequency of the space B (1785 Hz) and mark
Y (1615 Hz), using a spectrum analyzer.
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APPENDIX 1 ITU TELEX CHANNELS/
FREQUENCY LIST
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APPENDIX 2 INTERNATIONAL TELEX
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APPENDIX 3 Digital Interface
(IEC 61162-1 Edition 2)

Input sentences

GLL, RMA, RMC

Schematic diagram

IEC1162 (NMEA)
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Load requirements as listner

Isolation Optocoupler

Input impedance 470 ohms

Max. Voltage ± 15V

Threshold 4 mA
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GLL - Geographic position - latitude and
longitude

$--GLL,llll.lll,a,yyyyy.yyy,a,hhmmss.ss,A,a*hh<CR><LF>
              |     |          |        |              |      |   |   |
              |     |          |        |              |      |   |  +------- 6
              |     |          |        |              |      |  +--------- 5
              |     |          |        |              |      +----------- 4
              |     |          |        |             +---------------- 3
              |     |         +------+----------------------- 2
              +---+----------------------------------- 1

    1. Latitude, N/S
    2. Longitude, E/W
    3. UTC of position
    4. Status: A=data valid, V=data invalid
    5. Mode indicator(see note)
    6. Checksum

    NOTE  Positioning system Mode indicator:
          A = Autonomous
          D = Differential
          E = Estimated (dead reckoning)
          M = Manual input
          S = Simulator
          N = Data not valid

          The Mode indicator field supplements the Status field. The Status field shall be
          set to V=invalid for all values of Operating Mode except for A=Autonomous and
          D=Differential. The positioning system Mode indicator and Status field shall not
          be null fields.
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RMA - Recommended minimum navigation
information - Loran C data

$--RMA,A,llll.lll,a,yyyyy.yy,a,x.x,x.x,x.x,x.x,x.x,a,a*hh<CR><LF>
              |    |     |         |      |   |     |     |     |    |    |  |   |
              |    |     |         |      |   |     |     |     |    |    |  |   +------- 10
              |    |     |         |      |   |     |     |     |    |    |  +--------- 9
              |    |     |         |      |   |     |     |     |   +---+----------- 8
              |    |     |         |      |   |     |     |    +------------------ 7
              |    |     |         |      |   |     |    +---------------------- 6
              |    |     |         |      |   |    +-------------------------- 5
              |    |     |         |      |   +------------------------------ 4
              |    |     |        +----+--------------------------------- 3
              |    +---+-------------------------------------------- 2
             +------------------------------------------------------- 1

    1. Status: A=data valid, V=blink, cycle or SNR warning
    2. Latitude, degrees N/S
    3. Longitude, degrees E/W
    4. Time difference A, microseconds
    5. Time difference B, microseconds
    6. Speed over ground, knots
    7. Course over ground, degrees true
    8. Magnetic variation(see note 1),degree E/W
    9. Mode indicator(see note 2)
    10. Checksum

    NOTE 1 - Easterly variation(E) subtracts from true course
           Westerly variation(W) adds to true course

    NOTE 2  Positioning system Mode indicator:
          A = Autonomous
          D = Differential
          E = Estimated (dead reckoning)
          M = Manual input
          S = Simulator
          N = Data not valid

    The Mode indicator field supplements the Status field. The Status field
    shall be set to V=invalid for all values of Operating Mode except for 
    A=Autonomous and D=Differential. The positioning system Mode indicator 
    and Status field shall not be null fields.
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RMC - Recommended minimum specific GPS/
TRANSIT data

$--RMC,hhmmss.ss,A,llll.lll,a,yyyyy.yyy,a,x.x,x.x,xxxxxx,x.x,a,a*hh<CR><LF>
                     |           |    |     |           |      |    |    |       |         |   |   |   |
                     |           |    |     |           |      |    |    |       |         |   |   |  +--- 10
                     |           |    |     |           |      |    |    |       |         |   |   +----- 9
                     |           |    |     |           |      |    |    |       |        +--+------- 8
                     |           |    |     |           |      |    |    |       +--------------- 7
                     |           |    |     |           |      |    |   +--------------------- 6
                     |           |    |     |           |      |   +------------------------- 5
                     |           |    |     |           +---+---------------------------- 4
                     |           |    +---+---------------------------------------- 3
                     |          +--------------------------------------------------- 2
                    +---------------------------------------------------------- 1

    1. UTC of position fix
    2. Status: A=data valid, V=navigation receiver warning
    3. Latitude, N/S
    4. Longitude, E/W
    5. Speed over ground, knots
    6. Course over ground, degrees true
    7. Date: dd/mm/yy
    8. magnetic variation, degrees E/W
    9. Mode indicator(see note)
    10. Checksum

    NOTE  Positioning system Mode indicator:

          A = Autonomous
          D = Differential
          E = Estimated (dead reckoning)
          M = Manual input
          S = Simulator
          N = Data not valid

    The Mode indicator field supplements the Status field. The Status field
    shall be set to V=invalid for all values of Operating Mode except for 
    A=Autonomous and D=Differential. The positioning system Mode indicator 
    and Status field shall not be null fields.
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SPECIFICATIONS OF NBDP TERMINAL DP-6 
 

1. COMMUNICATIONS 

(1)  Communication Mode ARQ, FEC 

(2)  Communication Protocol ITU-R Rec. M.625-3, M.490, M.491-1 

(3)  ID Code 4, 5 and 9 digits 

(4)  Line Code  4B/3Y fixed mark (International) 

(5)  Modulation AFSK 

(6)  Tone Frequency 1615/1785 Hz, 1415/1585Hz, 

(mark/space) 1815/1985 Hz (±0.5Hz) 

(7)  Tone Frequency 

Tracking Range 80Hz 

(8)  Line Input/Output -30 dBm to +10 dBm, 600 ohms balanced 

 

2. COMMUNICATION FEATURES 

 Automatic transmission and receiving (maximum 10 stations)  

 Scramble operation (maximum 5 different code sets)   

 Frequency scanning (maximum 10 groups, 20 channels/group)  

 Morse code conversion (transmit only)   

 Storage for up to 100 user channels    

 Applicable to MARITEX. 

 

3. TERMINAL UNIT (IB-581) 

(1)  Display Monochrome 9.5" LCD 

(2)  Microprocessor ALI M6117, 33 MHz 

(3)  Memory Flash EPROM: 2 MB, DRAM: 2MB 

(4)  Disk Drive 720kB or 1.44kB 3.5" FDD 

(5)  Keyboard enhanced 82-key keyboard emulates the IBM PS/2 keyboard and  

 includes embedded numeric and cursor control overlay and dedicated 

  cursor control keys. 

 

4. OTHER FEATURES 

 Text editing screen 

  Floppy disk management 

  Nav data input and display 

  Remote control of transceiver 

  Printing 

  Self-test 
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5. ENVIRONMENTAL CONDITIONS 
(1)  Temperature -15ºC to +55 ºC 

(2)  Relative Humidity 93% (at 40 ºC) 

 

6. POWER SUPPLY 
(1)  Main Unit: 24 VDC: 0.84 A max. 

(2)  Terminal Unit: 24 VDC: 0.75 A max. 

 

7. COATING COLOR  
(1)  Main Unit:  Munsell 2.5GY5/1.5 

(2)  Terminal Unit Panel: Munsell N3.0 (not changed) 

  Cover: Munsell 2.5GY5/1.5 

 

8. PRINTER (PP-510) 
(3)  Printing Paper Plain, impact dot, 216mm wide, 80 characters/line 
(4)  Power Supply 24 VDC: 1.5 A max. 
(5)  Environmental Condition 

Ambient Temperature 5 to +35 ºC 

Relative Humidity 20 to 85% (non-condensing) 
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